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OWNER’S MANUAL

MODEL: FM37

Please read this manual carefully before operating
your set.
Retain it for future reference.

Designs and specifications are subject to change
without notice for improvement.



Warning
- To reduce the risk of fire or electric shock, do not

expose this appliance to rain or moisture.

Caution
- The appliance is not intended for use by young chil-

dren
or infirm persons without supervision.

- Young Children should be supervised to ensure that
they do not play appliance.

- Use of controls or adjustments or performance of
procedures other than those specified herein may
result in hazardous radiation exposure.
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CAUTION
RISK OF ELECTRIC SHOCK 

DO NOT OPEN

CAUTION: TO REDUCE THE RISK 
OF ELECTRIC SHOCK

DO NOT REMOVE COVER (OR BACK)
NO USER-SERVICEABLE PARTS INSIDE

REFER SERVICING TO QUALIFIED SERVICE
PERSONNEL.

Disposal of your old appliance

1. When this crossed-out wheeled bin sym-
bol is attached to a product it means the
product is covered by the European
Directive 2002/96/EC.

2. All electrical and electronic products
should be disposed of separately from the
municipal waste stream via designated
collection facilities appointed by the gov-
ernment or the local authorities.

3. The correct disposal of your old appliance
will help prevent potential negative conse-
quences for the environment and human
health.

4. For more detailed information about dis-
posal of your old appliance, please con-
tact your city office, waste disposal serv-
ice or the shop where you purchased the
product.

The working life of  this product is 7 years
since the date of purchase.

This product is manufactured to in compli-
ance with the radio interference require-
ments of EEC DIRECTIVE 89/336/EEC,
93/68/EEC and 73/23/EEC.



REGULATORY INFORMATION
FCC Part 15
This product has been tested and found to comply with
the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to pro-
vide reasonable protection against harmful interference
when the product is operated in a residential installation.
This product generates, uses and can radiate radio fre-
quency energy and, if not installed and used in accor-
dance with the instruction manual, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not
occur in a particular installation. If this product does
cause harmful interference to radio or television recep-
tion, which can be determined by turning the product
off and on, you are encouraged to try to correct the
interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the product and

receiver.
- Connect the product into an outlet on a circuit differ-

ent from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV tech-

nician for help.

Industry Canada requirement
- This Class B digital apparatus complies with Canadian

ICES-003.
- Cet appareil numérique de la classe B est conforme

qa la norme à NMB-003 du Canada.

Warning
- The lithium battery contains lithium and can explode

if it is not properly handled or disposed of.
- Replace only with a battery of the type recommended

by LG.
- Caution: Danger of explosion if battery is incorrectly

replaced. Replace only with the same or equivalent
type recommended by LG. Dispose of used batteries
according to the manufacturer's instructions.

FCC WARNING
This equipment may generate or use radio frequency 
energy. Changes or modifications to this equipment may
cause harmful interference unless the modifications are
expressly approved in the instruction manual.

You could lose the authority to operate this equipment
if an unauthorized change or modification is made.

- Changes or modifications not expressly approved by
the party responsible for compliance could void the
user's authority to operate the equipment.

- MP3 player is for use only with UL listed personal
computers that have installation instructions detailing
user installation of card cage accessory.
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CAUTION
PLEASE READ AND OBSERVE ALL WARNINGS
AND INSTRUCTIONS IN THIS OWNER MANUAL
AND THOSE MARKED ON THE UNIT. RETAIN THIS
BOOKLET FOR FUTURE REFERENCE.
This set has been designed and manufactured to assure
personal safety. Improper use can result in electric shock
or fire hazard. The safeguards incorporated in this unit
will protect you if you observe the following procedures
for installation, use, and servicing. This unit does not
contain any parts that can be repaired by the user.
DO NOT REMOVE THE CABINET COVER, OR YOU
MAY BE EXPOSED TO DANGEROUS VOLTAGE.
REFER SERVICING TO QUALIFIED SERVICE PER-
SONNEL ONLY.

1. Read these instructions.
- All these safety and operating instructions should be

read before the product is operated.
2. Keep these instructions.

- The safety, operating and use instructions should be
retained for future reference.

3. Heed all warnings.
- All warnings on the product and in the operating 

instructions should be adhered to.
4. Follow all instructions.

- All operating and use instructions should be followed.
5. Do not use this apparatus near water.

- For example:near a bath tub, wash bowl, kitchen
sink,
laundry tub, in a wet basement; or near a swimming
pool; and like.

6. Clean only with dry cloth.
- Unplug this product from the wall outlet before clean-

ing.
Do not use liquid cleaners.

7. Do not block any ventilation openings. Install in 
accordance with the manufacturers instructions.
- Slots and openings in the cabinet are provided for

ventilation and to ensure reliable operation of the
product and to protect it from over- heating.

- The openings should never be blocked by placing
the product on a bed, sofa, rug or other similar sur-
face.
This product should not be placed in a built-in instal-
lation such as a bookcase or rack unless proper ven-
tilation is provided or the manufacturer instructions
have been adhered to.

- Important Safety Instructions
8. Do not install near any heat sources such as radiators,

heat registers, stoves, or other apparatus (including
amplifiers) that produce heat.

9. Do not defeat the safety purpose of the polarized or
grounding-type plug. A polarized plug has two blades
with one wider than the other. A grounding type plug
has two blades and a third grounding prong. The wide
blade or the third prong are provided for your safety.
- If the provided plug does not fit into your outlet, con-

sult an electrician for replacement of the obsolete
outlet.

10.Protect the power cord from being walked on or
pinched particularly at plugs, convenience receptacles,
and the point where they exit from the product.

11. Only use attachments/accessories specified by the 
manufacturer.

12.Use only with the cart, stand, tripod, bracket, or table
specified by the manufacturer, or sold with apparatus.
- When a cart is used, use caution when moving the

cart/apparatus combination to avoid injury from tip
over.

13.Unplug this apparatus during lightning storms or
when unused for long periods of time.

14.Refer all servicing to qualified service personnel.
Servicing is required when the apparatus has been
damaged in any way, such as power- supply cord or
plug is damaged, liquid has been spilled or objects
have fallen into the apparatus, the apparatus has
been exposed to rain or moisture, does not operate
normally, or has been dropped.
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Portable Data Storage
Easy storage and transfer of any file type.

USB 1.1 and 2.0
You can download files at a fast speed. 
(USB  2.0 high speed)

FM Reception (Option by models)
With auto frequency selection feature, you can 
conveniently listen to FM radio broadcasting.

LG 3D Sound
3D sound effects, low tones, and low frequency
sound provide greater sound quality.

Text Viewer
Convenient display of text files (.txt) for reading on
the go.

Photo Viewer
Store and display photos on the vivid display for
entertaining slide shows.

2.4" Color TFT LCD
Photos and video are reproduced in vivid detail on
the highly portable 260,000 color TFT LCD.

Touch screen
You can use the menus and functions of MP3 player
by touching the LCD.

File Format Flexibility
- Music: MP3, OGG, WMA, WAV (ADPCM), ASF
- Video: LG AVI/ LG WMV (MP3 player can only play

the video files downloaded via LG Media 
Center.)

- Photo: JPG
- Text: TXT

Media Device(MTP) Mode / Removable
Disk(MSC) Mode
What is the Media Device(MTP) mode?
The MTP stands for the Media Transfer Protocol. It
applies the latest technology defined by Microsoft to
support multimedia devices.
- Windows XP / SP1 or higher OS, and Windows 

Media Player 10.
- To use the MSC mode, select the MSC mode in the 

PC Connection Setting menu.
- If the Windows OS does not support the MTP, the 

player will function in the MSC mode although the 
player is set in the MTP mode (Select the MSC 
mode for the USB in the setup menu for Windows 
98 SE/ ME).

What is the Removable Disk(MSC) mode?
The MSC stands for the Mass Storage Class. The
device in MSC mode functions like a portable 
memory.
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Keep this product away from heat. 

Note that MP3 player may malfunction in an
electrostatic environment.

Use the AC adapter shipped with the product
for the safety purposes.

Disconnect the AC adapter and the cable in
case of a lightning or thunder. Otherwise, an
electric shock or fire may occur.

Do not use this product while driving.

Do not insert a metallic object (metal stick
or hair pins, etc) or flammable objects in
the product. Do not drop such objects on
the product either.

Don’t listen to music for a long time. It may
damage your hearing.

Do not place MP3 player near a magnet
or within the magnetic field.

Do not drop an object or give shock on 
the product.

Clean this product with soft cloth.

Do not operate the product near water, dust,
or soot.

Do not disassemble, repair, or remodel the
product.

Do not disconnect the USB cable while 
operating MP3 player after connecting MP3
player to your PC with USB cable.
Otherwise, the data may get lost.

Do not place an object on the product. 

Back up important data (Note that the 
manufacturer is not responsible for the loss
of major data caused by your mistake)

Please follow the safety instructions closely to reduce the risk of accidents or damage to equipment.

Safety instructions are divided into Warning and Attention:

Keep this manual in an easily accessible place.

Not following the instruction 
may result in death or serious 
injury.

Warning
Not following the instruction
may result in a light accident or
damage.

Caution

Warnings Cautions
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Converting video file
MP3 player can be only played the video files 
downloaded via LG Media Center.
For details about download, see the Help menu
[Converting video file] on LG Media Center.

PC Connection Setting
Media Device(MTP) Mode
You should download music files via LG Media
Center or Windows Media Player 10 or higher.
You should download video, photo, and text files via
LG Media Center.
You can copy data files to the Data folder. (You can’t
see the data folder in your MP3 player.)

Removable Disk(MSC) Mode
You can copy the Media file to the Removal Disc.
(But you should download video files via LG Media
Center.)

Supplying Power via USB
- If the battery status is low when connecting MP3 

player to your PC with USB cable MP3 player may 
not be connected for a few minutes.

- If the battery is fully discharged, the LCD turns off 
for a few minutes even during connecting.

- If your PC is suspended, MP3 player is also 
suspended.

- If MP3 player is suspended, the LCD turns off and 
the charging stops. After an hour, MP3 player 
turns off automatically.

Package contents

MP3 player USB cable 

AC adapter Earphones

- The images inserted herein are examples to make
users understand the more easily and may be little
bit different from the real product.

- The contents of the product are subject to change
without prior notice for functional improvement.

- Radio function is optional depending on the models.
- An AC adapter may not be supplied depending on

the models.
- Contact with one of call centers supplied with this 

quick setup guide to buy an AC adapter.

Option by models

Software CD
(Including a
detailed manual) 

Quick Setup Guide

Model name

MF-FM37S

MF-FM37E

MF-FM37F

MF-FM37Y

FM Radio

O

X

O

X

AC adapter

X

X

O

O



1 Microphone hole/ RESET button 

2 Record (REC) button

3 Earphone jack

4 USB port

5 LCD (*Touch screen)

6 • Power on/off switch ( )

• Hold switch ( )
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1

2

3

6

5

4

* Precautions in using the touch screen
zz Use the touch screen with clean and dry hands.  

- In a humid environment, wipe out any moisture on the touch screen before using.
zz Do not press the touch screen hard to make it work. 

- If you apply too much strength, it can damage the sensor of the touch screen.
zz Touch the point that you want to work in order to operate the function correctly. 
zz Be careful not to have any conductive material such as metallic object on the touch screen. It can cause

malfunctions. 



Before installing the operating
program
Check the specifications of your PC before using
MP3 player.

Minimum system requirements
- CD-ROM Drive
- Pentium Ι ΙΙ or higher level CPU / 128MB or larger

memory
- 300MB or larger hard disc space, 800 X 600 mode
- Hi-color (16 bit) or higher level video card, Sound card

Operating environment
The MTP mode is applied to the PC equipped with
Windows XP (SP1) or higher-version OS or the Windows
Media Player 10 or higher. To the lower-version OS, the
MSC mode is applied.

Windows Media Player 10
- You can download the file using Synchronize with

Windows Media Player 10 menu.
- For more information, see the Help menu of Windows

Media Player 10.

LG Media Center
- Windows 2000/XP
- Windows Media Player 10 or higher / Internet Explorer

6.0
- Windows Media Player or Internet Explorer will be

automatically installed during installation of the LG
Media Center. Internet connection must be connected
in order to install Internet Explorer.

- The LG Media Center is recommended for MTP mode.

About LG Media Center
The LG Media Center program is an integrated data
management program developed for users to more
conveniently use the MP3 player.

Features of the LG Media Center

You can efficiently manage music, video, photo, and text
files through the Media Library rule and download them
to the MP3 player.

Contents Service menu

- Music Store: Music purchase, Streaming service
- Media Cast: Music, vide, broadcasting service 

purchase (Period-based service)
- For more information, see the Help menu of the pro-

gram or visit www.lge.com.
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Installing LG Media Center
1 Insert the operation program CD into the CD-ROM.

2 Select [LG Media Center].

3 Follow the displayed instructions.
4 Read the License Agreement. Select the check box

and click [Next].

5 Select the installation path and click [Next].

6 Click [Install] to start installation.

7 After finishing the installation, click [Finish].

8 Click [Start] k [All Programs] k [LG Media Center]
k [LG Media Center] to start the program.

During installation of the LG Media Center, you can
install the Windows Media Player and the Internet
Explorer for an operating environment.
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Installing Win98SE MSC Device
Driver

1 Execute LGE203053 inst.bat under Drivers k
Win98SE folder in the CD-ROM. 

2 Reboot the PC and connect the MP3 player to the
USB port.

3 The installed device driver can be used as a portable
disc in the Windows Explorer.

4 Check the installation status in System Properties as
shown below.

Installation of the Adobe Acrobat
Reader
1 Insert the operation program CD into the CD-ROM.

2 Select [Adobe Acrobat Reader].

3 Follow the displayed instructions.

View the manual
1 Insert the operation program CD into the CD-ROM.

2 Select [Manual].

3 You can see the manual.

You must install the Adobe Acrobat Reader to read the
manual.
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To connect the USB cable
1 Connect one end of the USB cable to the USB port of

the PC and the other to the USB port of MP3 player.
- Check whether both ends are correctly plugged in.

2 If the USB device is normally recognized after the
cable is connected, the “USB connected” and firmware
version appear on LCD.

3 In case of a correct connection, an icon will be 
displayed on the task bar of the PC.
- The icon shapes on the task bar may differ depending on

the OS of the PC.

Note
- The MP3 player may not operate properly because of

other USBs connected to the PC.
- You can not use the touch screen when the USB device

is connected.

To disconnect the USB Cable
Media Device(MTP) mode
Disconnect the USB cable from the PC after checking
whether a file is transferring.
If the file is transferring, disconnect it after the transfer is
completed.

Removable Disk(MSC) mode
This feature is to safely remove MP3 player from the PC
after uploading or downloading the files.

1 Double-click on the Remove Hardware icon on the
task bar of the PC.

2 Click [Stop] when the window appears.

3 Click [OK].

4 After a message that the large-capacity USB storage
can be safely removed is displayed, remove MP3
player from the PC.
- If the USB cable is disconnected while storing or delet-

ing the file, the data may get lost.
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To download files - MTP mode
MP3 player will be recognized as a mobile device, not a
mass storage, and will interwork with the Windows
Media Player 10 or higher

1 Check whether the device is connected through the
MTP mode.

- [Settings] of Home Menu  k [General] k 

[PC Connection Setting] k [Media Device (MTP)]

2 Connect one end of the USB cable to the USB port of
the PC and the other to the USB port of MP3 player.

- Check whether both ends of the cable are correctly
plugged in.

3 The window “MTP Media Player” appears in the PC.

1) a. “Synchronize media files to this device” k “OK”

b. “Manual” k “Finish”

c. Drag the synchronizing files to the left window.

d. Click “Start Sync”.
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2) a. “Take no action” k “OK”

b. Click “LGE MTP PLAYER-FM37”.

- Data folder: You can download or upload all data 
files.

- Media folder:You can download only the file that 
Windows Media Player 10 or higher 
supports.

4 Drag the file to copy to the potable media drive.

To download files - MSC mode
1 Check whether the device is connected through the

MSC mode.
- [Settings] of Home Menu  k [General] k 

[PC Connection Setting] k Removable Disk (MSC)

2 Connect one end of the USB cable to the USB port of
the PC and the other to the USB port of MP3 player.
- Check whether both ends of the cable are correctly

plugged in.

3 Check whether a new drive has been added in the
Windows Explorer in the PC.
- The drive name may differ depending on the OS.

4 Drag the file to copy to the removable disc drive.

- Disconnecting the USB cable while the file is being
copied may cause malfunction of MP3 player.

- MP3 player will be charged when connected to the PC
through the USB cable.

- Download video files from LG Media Center.

- Download the JANUS DRM-applied files through the
Windows Media Player 10 or higher, or LG Media Center
(MTP Mode only)

- Download X-Sync DRM-applied files through the LG
Media Center.
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To download files - LG Media
Center
You can download from MP3 player the files you want
via LG Media Center.
For details, see the Help menu on LG Media Center.

- You can check the downloaded files in the Music,
Video, Photo, or Document folder.

- OGG files only are supported in MSC mode.

1 Connect one end of the USB cable to the USB port of
the PC and the other to the USB port of MP3 player.
- Check whether both ends of the cable are correctly

plugged in.

2 Execute the LG Media Center and then click [Add
Library]. 

3 [Add file] k Selecting the downing file (Ex: Music file)
k [Start] k [Ok] k [Close]

4 [Music] k [Send to the Connected Device]

5 Drag the files to the [Send to the Connected Device]. 

6 Click [Transmission Waiting List] k [Start sync].
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MP3 player can only play the video files downloaded via
LG Media Center.
For details about download, see the Help menu
[Converting video file] on LG Media Center.

1 Execute the LG Media Center and then click [Video]. 

2 Click [Add Library]. 

3 [Add file] k Selecting the downing file (Ex: Music file)
k [Start] k [Ok] k [Close]

4 Selecting the video file k [Tools] k [Advanced
Tools] k [Convert Format]

- You can add other video file when you press [Add file] in
“Add to the Media Library” menu. 

- You can delete the video file when you press the [Cancel
selection] after selecting the video file you want to delete
in “Add to the Media Library” menu. 

5 Check the video file and then select the Model,
Resolution, and Output in [Convert Format] menu.

6 Click [Start]. 
- The video file is converted.

- After converting, check the video file where the file is .

- For details, see the Help menu on LG Media Center.
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To upgrade firmware automatically
Connect MP3 player to the PC where the LG Media
Center is installed to download a new version of
firmware.
- Functions only in the Internet-connected PC.
- Back up important data before upgrading, or the data

may get lost.

1 Connect one end of the USB cable to the USB port of
the PC with the LG Media Center installed and the
other to the USB port of MP3 player.

2 The LG Media Center will compare the firmware ver-
sions of MP3 player and the server. If it detects a new
firmware version, it asks you whether to upgrade the
version.

3 Click [OK] to copy new firmware to the MP3 player.

4 Upon updating, new version firmware will be copied to
the MP3 player.

5 To safely remove the device, remove the USB cable.
(In MSC mode)

6 When "Firmware upgrade?" message is displayed,
click the REC.

7 The firmware updating progress bar will be displayed.
After the upgrade is completed, the power will be 
automatically turned off.
- Wait till the power is automatically turned off.

8 Turn on the MP3 player and check the upgraded 
version of firmware.
- You can check the firmware version in Home Menu

[Settings] of Home Menu  k [General] k [System
Info]

To upgrade firmware manually
You can upgrade the firmware for addition and
change of features of MP3 player and for functional
improvement.

1 Check the model number at the company website, and
download the latest version.

- http://www.lge.com k Support k Download k Software
(The contents may differ depending on the website.)

2 Decompress the downloaded files. Then, FM37.rom
file will be displayed.

3 Connect the USB cable to the MP3 player and the PC.

4 Check whether a new drive has been added in the
Windows Explorer in the PC.

- The drive name may differ depending on the OS.

5 Select the FM37.rom file and copy it to the newly
added drive.

- In MSC mode: Highest root

- In MTP mode: Data folder

6 To safely remove the device, remove the USB cable.

7 When "Firmware upgrade?" message is displayed,
click the REC.

8 The firmware updating progress bar will be displayed.
After the upgrade is completed, the power will be 
automatically turned off.

- Wait till the power is automatically turned off.

9 Turn on the MP3 player and check the upgraded 
version of firmware. 
- You can check the firmware version in Home Menu 

[Settings] of Home Menu  k [General] k [System 
Info]
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AC adapter
Charge the MP3 player with the supplied AC
adapter.
1 Connect the AC adapter to the AC outlet.
2 Connect the USB cable of AC adapter to the USB port

of MP3 player.

- On the display of MP3 player, the charging status will
be displayed as follows: (Charging time: 3 hours)

Note
- Do not disconnect AC Adapter before booting of MP3

player is completed. The data may get lost.
- Use the supplied AC adapter when you charge the MP3

player, otherwise the MP3 player may malfunction.
- Do not charge MP3 player for longer than 12 hours.

Overcharge and overdischarge may shorten the battery
life.

- If you transfer files on charging, the charging time will be
extended.

- Charge the battery in a place with a normal temperature.

USB cable
MP3 player will be also automatically charged when
connecting the PC and MP3 player with USB cable.
- On the display of MP3 player, the charging status will

be displayed as follows: (Charging time : More than 4
hours)

Note
- MP3 player may completely discharged first time you

purchase the product. Charge the battery first.
- Charging time may vary according to PC system

requirements or operating environment. If your PC is
suspended, MP3 player is not charged.

- Do not charge MP3 player for longer than 12 hours.
Overcharge and overdischarge may shorten the battery
life.

- After checking  the state of a remaining battery of note
book, connect the USB cable and charge it.

- Do not charge it when the remaining battery of the note
book is not enough.

- If you transfer files on charging, the charging time will be
extended.

- Charge the battery in a place with a normal temperature.
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To Turn on/off the power
Turn on the power

Push the power on/off switch in the direction of the 
until MP3 player is turned on.
- Downloading files in MSC mode may take 

time for rebuilding depending on the number of files.

Turn off the power
Push the power on/off switch in the direction of the 
until MP3 player is turned off.

Lock feature
This feature locks MP3 player to prevent it from
operating when you accidentally press a button.

1 Push the power on/off switch in the direction of the 
to lock MP3 player.

- Upon locked status, will be displayed on LCD. 

Upon pressing of each button, will appear for two
seconds and disappear.

2 Push the power on/off switch in the opposite direction

of the button to unlock the device.

Reset feature
This feature is to reset the player when the MP3 
player does not operate normally.

1 Prick the hole with a sharp object when the MP3 player
does not operate normally.

2 After the power is turned off, push the power on/off

switch in the direction of the . Then, the power will
be turned on.
- When MP3 player is connected to PC with USB cable, it

will be automatically turned on.

- Reset function initializes setting values.

Locked

Locked
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Music screen

Movie screen

1 Moves to the previous menu or home menu.

2 Playback time

3 Bookmark display

4 Play mode display

5 Playing time bar

6 Remaining time

7 Music information display 
(Album, Artist, Title)

8 Image/Lyrics

9 Moves to the EZ menu.

10 Moves to the control box. (Play/ Pause/ Volume/
Skip/ A-B repeat)

11 Battery status

1 Moves to the EZ menu.

2 Moves to the control box. 
(Play/ Pause/ Volume/ Skip)

3 Battery status

4 Title of the video file

5 Moves to the previous menu or home menu.

6 Bookmark display

7 Playback time

8 Playing time bar

9 Remaining time

10 Playing screen
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Photo screen

FM radio screen 
(Option by models)

1 Moves to the previous menu or home menu.

2 Enlarging/ Reducing the photo

3 Music/ Radio display

4 File name

5 Photo screen

6 Moves to the EZ menu.

7 Moves to the control box. (Slide show/ Volume/ Skip)

8 Battery status

1 Moves to the previous menu or home menu.

2 Non preset mode/ Preset mode

3 FM radio frequency display

4 Moves to the EZ menu.

5 Moves to the control box (Play/ Mute/ Volume/ Mode)

6 Battery status
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Text screen

Recording screen

1 Moves to the previous menu or home menu.

2 Bookmark display

3 Current page/ Total page

4 Music/ Radio display

5 Text display

6 Title of the text file

7 Moves to the EZ menu.

8 Moves to the control box. (Auto page/ Volume/ Skip)

9 Battery status

1 Moves to the previous menu or home menu.

2 Record display (Start/ Pause/ Continue)

3 Title of the recording file

4 Recording standby/ Recording time

5 Recording end

6 Moves to the EZ menu.

7 Battery status
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Home menu screen
You can operate various features by using the Home
menu.

* Home menu screen varies according to product models
(FM radio reception is optional.)

The section marked with red line is specified as “middle
part” in this manual.

1 Music : Moves to the music mode.

2 Movie : Moves to the video mode.

3 Photo : Moves to the image mode.

4 Radio : Receives and records FM broadcasting.
(FM radio reception is optional.)

5 Text : Moves to the text mode.

6 All Files : Displays the playable total list.

7 Game : Moves to the game mode.

8 Settings : Sets the operating environment of the 
player.

General operations of Home
menu
1 Turn the MP3 player on.

- The home menu appears on LCD.

2 Press the icon of a desired menu.

3 Press the icon of selected menu.

4 Press the desired menu to move to the second level
and then press the selected menu to execute the
menu.

Note
- Press to return to the previous menu during 

operation.

- Press and move to the right downward direction
to return to the home menu during operation.

- Press and move to the left upward direction to
return to the previous menu in the home menu.
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Music menu

Last Played File
Plays the last played music file.

Random play all
Plays the music file randomly.
- When you set [Random play all] during operation, the

play mode is changed to [Random all].

Playlist
• My Playlist

You can select and manage your own playlist.

• PC Playlist :
The playlist created in the WMP(Windows Media Player
10 or higher) or the LG Media Center can be automati-
cally displayed on the MP3 player through the Auto
Sync mode.
- When the playlist and corresponding files are

unchecked in the Auto Sync mode, music will be
deleted in the MP3 player. It is recommended to keep
all Music files always checked.

All music
Displays the total music.

Artist
Displays the music by artist.

Album
Displays the music by album.

Genre
Displays music by genre.

Recorded File
Plays the radio recording file (Option by models) or voice
recording file.

Note
The selected file is played when you select the desired
file.
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To play the music file
1 Select of the home menu.

2 Select the desired menu and then press a music file
you want to play.
- If you select the [Last Played File] menu, the last played 

music file will be played at once.

Pause
1 Press the middle part of LCD during playback. 

2 Press the middle part of LCD again to resume 
playback.

Using the control box
1 Press during playback.

- The control box appears on LCD.

- If the control box does not appear on LCD, adjust 
the control box. [Ez menu] k [Control Box] k [On] 
(Page 29)

2 Press to pause.

- The appears on LCD.

3 Press to resume playback.

4 Press or other space to remove the control box.
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To play the previous or next file
Drag the middle part of LCD in the direction of the
left/right  during playback. 

- If you drag the LCD from right to left after five 
seconds of playing time, the current file will be 
played from the beginning.

- If you drag the LCD from right to left within five 
seconds of playing time, the previous file will be 
played from the beginning.

Using the control box

1 Press during playback.
- The control box appears on LCD.

2 Press / button to play the previous or next file.

- If you press after five seconds of playing time, the 
current file will be played from the beginning.

- If you press within five seconds of playing time, the 
previous file will be played from the beginning.

Speed search
Drag the LCD during playback and then press and hold
the LCD.

Using the control box
1 Press during playback.

- The control box appears on LCD.

2 Press and hold / button for two seconds during
playback. And then release at a point you want.
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To play from a specific point
1 Press the playing time bar to play from a specific point

you want during playback.
- The control box appears on LCD.

2 Press / / / .

- : Moves to the point of playing time before 1 minute.
If the playing time is less than 1 minute, the current 
file moves to the beginning point.

- : Moves to the point of playing time before 
5 seconds.

- : Moves to the point of playing time after 
5 seconds.

- : Moves to the point of playing time after 1 minute.
If the remaining time is less than 1 minute, the 
current file moves to the beginning point of next 
music.

A-B section repeat

This feature can only set the current playing music.

1 Press during playback.
- The control box appears on LCD.

2 To set the starting point during playback, press .

- “A” icon appears on LCD.

3 To select the ending point, press again. Then, the
Repeat feature will be set.

- “B” icon appears on LCD.

4 To cancel Repeat feature, press again.

- “A” and “B” icons disappear on LCD.

Volume control
Keep pressing and turn the point you press on LCD
clockwise/counterclockwise during playback.

Volume up

Volume down

Using the control box
1 Press during playback.

- The control box appears on LCD.

2 Press or to control the volume.+-

A-B

A-B

A-B

DIGITAL

MUSIC
PLAYER Playing music

28

A-B

+

-

A-B

+

-

12

24



EZ menu of the Music
You can set the desired function or switch to other
modes using the EZ menu.
Press to select the EZ menu during playback.

Bookmark
You can start playback from memorized point.
• Set : Sets the bookmark.
• Move : Executes the bookmark.
• Cancel : Cancels the bookmark.

Simultaneous View
• Photo : You can view the photo while listening to the 

music simultaneously.
[Photo] k [ (Moving to EZ menu of the 
photo] k [Music] k [Cancel]/[Play Previous]/ 
[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays the previous music.
- [Play Next] : Plays the next music.
- [Back] : Moves to the music mode.

• Text : You can view the text while listening to the 
music simultaneously.

[Text] k [ (Moving to EZ menu of the 
text] k [Music] k [Cancel]/[Play Previous]/ 
[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays the previous music.
- [Play Next] : Plays the next music.
- [Back] : Moves to the music mode.

Create My Playlist/Delete My Playlist
Creates or deletes files in my playlist.

Play Mode
• Repeat One

Plays the current file repeatedly.
• Play All

Plays all music within the selected folder in order.
• Repeat All

Plays all music within the selected folder repeatedly.
• Random All

Plays all music within the selected folder randomly.
• Random Repeat All

Repeats all music within the selected folder randomly.

EQ
You can set the sound effect.
• AUTOEQ, NORMAL, POP, ROCK, R&B/SOUL,

HIPHOP/RAP, JAZZ, CLASSICAL, DANCE, LIVE,
USER EQ

3D Sound
You can experience 3D sound effects.
• Off, 3D EXPANDER, STADIUM, CONCERT HALL,

CLUB, ROOM, BASS BOOST, X-LIVE

Lyrics
You can show the lyrics if a music file supports the lyrics.
• On : Sets the lyrics view.
• Off : Cancels the setting of lyrics view.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Background Setting
You can select the photo file for music background.
• Album Art

Displays the album jacket during playback.
• User Image

Displays the user’s photo during playback.
• Default Image

Displays the basic photo during playback.

Control Box
You can select the control box.
• On : Displays the control box.
• Off : Cancels the display of control box.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(Bitrate, File Size, Sampling, Codec, Setting)
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To play the movie file
MP3 player can only play the video files downloaded
via LG Media Center. For details about download, see
the Help menu [Converting  video file] on LG Media
Center.

1 Select of the home menu.

2 Select the desired file.
- The list is displayed on LCD.
- If there is no list, “No file” appears on LCD.

3 Press the desired file.
- The movie file is played.
- The movie file will be displayed on the horizontal screen.

Pause
1 Press twice the middle part of LCD during playback. 

2 Press twice the middle part of LCD again to resume
playback.

Using the control box

1 Press the LCD during playback.

2 Press .
- The control box appears on LCD.

- If the control box does not appear on LCD, adjust the
control box. [Ez menu] k [Control Box] k [On] 
(Page 33)

3 Press to pause.

- The appears on LCD.

4 Press to resume playback.

5 Press or other space to remove the control box.
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To play the previous or next file
1 Press the LCD during playback.
2 Drag the middle part of LCD in the direction of the

left/right during playback.  

- If you drag the LCD from right to left after five 
seconds of playing time, the current file will be 
played from the beginning.

- If you drag the LCD from right to left within five 
seconds of playing time, the previous file will be 
played from the beginning.

Using the control box

1 Press the LCD during playback.

2 Press .
- The control box appears on LCD.

3 Press / to play the previous or next file.

- If you press after five seconds of playing time, the 
current file will be played from the beginning.

- If you press within five seconds of playing time, the 
previous file will be played from the beginning

Speed search
1 Press the LCD during playback.
2 Drag the middle part of LCD in the direction of the

left/right  during playback and then press and hold the
LCD.

Using the control box

1 Press during playback.
- The control box appears on LCD.

2 Press and hold / button for two seconds during
playback. And then release at a point you want.
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To play from a specific point
1 Press the LCD during playback.
2 Press the playing time bar to play from a specific point

you want during playback.
- The control box appears on LCD.

3 Press / / / .

- : Moves to the point of playing time before 1 minute.
If the playing time is less than 1 minute, the current 
file moves to the beginning point.

- : Moves to the point of playing time before 
5 seconds.

- : Moves to the point of playing time after 
5 seconds.

- : Moves to the point of playing time after 1 minute.
If the remaining time is less than 1 minute,the cur-
-rent file moves to the beginning point of next 
music.

Volume control
Keep pressing and turn the point you press on LCD
clockwise/counterclockwise during playback.

Volume up Volume down

Using the control box

1 Press the LCD during playback.

2 Press .
- The control box appears on LCD.

3 Press or to control the volume.+-
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EZ menu of the Movie
You can set the desired function or switch to other
modes using the EZ menu.

Press to select the EZ menu during playback.

Bookmark
You can move to the point you set while playing the
video.
• Set

Sets the bookmark.
• Move

Executes the bookmark.
• Cancel

Cancels the bookmark.

Search Speed
You can set the playing speed of movies files.
• 1 time

Plays at an original speed.
• 2 times

Plays at 2 times speed.
• 3 times

Plays at 3 times speed.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Control Box
You can select the control box.
• On : Displays the control box.
• Off : Cancels the display of control box.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(File Name, Full Time , File Size, Setting)
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To view the photo file
1 Select of the home menu.

2 Press the desired file.
- The list is displayed on LCD.
- If there is no list, “No file” appears on LCD.

3 Press the desired file.
- The photo file appears on LCD.

Note
MP3 player may not be played a black-and-white photo
or large-capacity file.

To set the slide show
1 Press the middle part of LCD when a photo file is 

displayed.

2 Press the middle part of LCD again to pause.

Using the control box

1 Press during playback.
- The control box appears on LCD.

- If the control box does not appear on LCD, adjust the 
control box. [Ez menu] k [Control Box] k [On] 
(Page 36)

2 Press to set the slide show.

- The appears on LCD.

3 Press to pause.

- The appears on LCD.

4 Press or other space to remove the control box.
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To view the previous or next file
Drag the middle part of LCD in the direction of the
left/right during playback.  

Using the control box

1 Press during playback.
- The control box appears on LCD.

2 Press / button to view the previous or next photo.

Volume control
When you listen to music or radio while viewing the
photo file, control the volume. (FM radio reception is
optional.)

Keep pressing and turn the point you press on LCD
clockwise/counterclockwise during playback.

Volume up

Volume down

Using the control box

1 When you listen to music or radio while viewing the

photo file, press .
- The control box appears on LCD.

2 Press the or button to control the volume.+-
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EZ menu of the Photo

You can set the desired function or switch to other
modes using the EZ menu.

Press to select the EZ menu while viewing the
photo.

DUAL
You can listen to music or radio while viewing the photo
file. (FM  radio reception is optional.)
• Music : You can listen to music while viewing the photo

file.
[Music] k [ (Moving to EZ menu of the
photo] k [Music] k [Cancel]/[Play Previous]/ 
[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays previous music.
- [Play Next] : Plays next music.
- [Back] : Moves to the music mode.

• Radio : You can listen to radio while viewing the photo
file.
[Radio] k [ (Moving to EZ menu of the 
photo] k [Radio] k [Cancel]/[Previous 
Channel]/[Next Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous 

channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

Slide Show
You can set the slide show to On/Off.
• On

Turns on the slide show.
• Off

Turns off the slide show.

Slide Interval
You can set the slide show interval to [2 sec], [3 sec], 
[4 sec],or [5 sec].

View 4 slides
You can show 4 slides on one screen.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Background Setting
• Music Background

You can select photo file to music background on the
photo mode.

• Radio Background
You can select photo file to music background on the
radio mode.

Control Box
You can select the control box.
• On : Displays the control box.
• Off : Cancels the display of control box.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(File Name, File Kind, File Size, Setting)
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To preset to the FM radio
1 Select of the home menu.

2 If you store the channel press [Yes], otherwise press
[No].
- You can save maximum 20 channels and existing

channels will be deleted.
- In an area with weak reception, the detected channels

may be less than 20.

3 The FM radio broadcasting is received.

To listen to the FM radio
1 Select of the home menu.

- The stored channel list is displayed on LCD.

2 Select the channel you want on the channel list.
- You can listen to the FM radio.

Note
Press and move to the right downward direction to
return to the home menu on the preset mode.

Mute the sound
1 Press the middle part of LCD while listening to the

radio. 

2 Press the middle part of LCD again to listen to the
radio.

Using the control box

1 Press while listening to the radio.
- The control box appears on LCD.

- If the control box does not appear on LCD, adjust the 
control box. [Ez menu] k [Control Box] k [On] 
(Page 40)

2 Press to set muting.

- The appears on LCD.

3 Press to listen to the radio.

4 Press or other space to remove the control box.
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To search the FM radio stations
Manual Search
Drag the middle part of LCD in the direction of the
left/right while listening to the radio. 

Using the control box
1 Press while listening to the radio.

- The control box appears on LCD.

- Press on LCD until the and appear on 
Non-Preset Mode.

- Press on LCD until the and appear on
Preset Mode.

Automatic Search
Drag the middle part of LCD in the direction of the
left/right during reception and then press and hold the
LCD.

Using the control box
1 Press while listening to the radio.

- The control box appears on LCD.

- Press on LCD until the and appear on LCD.

2 Press , .

- If you press during automatic search, it is canceled.
- Reception may be weak in some areas.
- As earphones function as antennas, only LG

Electronics' earphones guarantees the reception 
quality.

Mode Mode

Mode ModeMode Mode

Mode ModeMode Mode

Mode Mode

Ch +Ch - Ch +Ch -

Mode Mode

Ch +Ch - Ch +Ch -

Mode Mode

Mode ModeMode

Mode ModeMode Mode

Mode ModeMode
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Volume control
Keep pressing and turn the point you press on LCD
clockwise/counterclockwise while listening to the radio. 

Volume up

Volume down

Using the control box
1 Press during while listening to the radio.

- The control box appears on LCD.

2 Press the or button to control the volume.

To record FM radio broadcasting
1 To record while listening to the radio, press REC 

button more than 1 second.
- The recording time will be displayed and the recording

will start.

2 Press [Pause] to pause.
3 Press [END] to end the recording.

- Select [Continue] to resume recording.
- The recorded files will be stored under Record folder

named F061205_xxxx (Year Month Date_Order)

4 Refer to [Recorded file] on page 25 to play prerecord-
ed files.

Note
If the remaining memory space is less than 4MB, the 
player may not be recorded.

+-
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EZ menu of the Radio
You can set the desired function or switch to other
modes using the EZ menu.

Press to select the EZ menu while listening to the
radio.

Simultaneous View
• Photo : You can view the photo while listening to the 

radio simultaneously.
[Photo] k [ (Moving to EZ menu of the
photo)] k [Radio] k [Cancel]/[Previous
Channel]/[Next Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous

channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

• Text : You can view the text while listening to the 
radio simultaneously.

[Text] k [ (Moving to EZ menu of the text)]
k [Radio] k [Cancel]/[Previous Channel]/
[Next Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous

channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

Delete Channel/Save Channel
Deletes or stores a radio channel.

Channel Search
You can store the FM radio channel automatically.
- The previous memorized channel will deleted.
- Press [Cancel] to stop while searching the channel.

Radio Mode
You can select the channel mode or frequency mode.

• Preset Mode
You can set the FM radio broadcasting to channel
mode.

• Non-Preset Mode
You can set the FM radio broadcasting to frequency
mode.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Background Setting
You can select the photo file to background while listen-
ing to the radio.
• User Image

Displays the user’s photo during playback.
• Default Image

Displays the basic photo during playback.

Control Box
You can select the control box.
• On : Displays the control box.
• Off : Cancels the display of control box.

View Information
Displays the information of the receiving radio.
(Frequency, Reserved REC Interval, Reserved REC
Time , Reserved frequency, Setting)
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To view the text file
1 Select of the home menu.

2 Select the desired list.
- The list is displayed on LCD.
- If there is no list, “No file” appears on LCD.

3 Press the desired file.
- The text file appears on LCD.

Note
The player supports maximum 99999 pages.

To skip the page automatically
1 Press the middle part of LCD when a text file is 

displayed.

2 Press the middle part of LCD again to pause.

Using the control box
1 Press while viewing the text.

- The control box appears on LCD.

- If the control box does not appear on LCD, adjust the 
control box. [Ez menu] k [Control Box] k [On] 
(Page 43)

2 Press to skip the page automatically.

- The appears on LCD.

3 Press to pause.

- The appears on LCD.

4 Press or other space to remove the control box.
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To view the previous or next page
Drag the middle part of LCD in the direction of the
left/right during playback.  

Using the control box
1 Press during playback.

- The control box appears on LCD.

2 Press / to view the previous or next page.

Speed search
Drag the LCD during playback and then press and hold
the LCD.

Using the control box
1 Press during playback.

- The control box appears on LCD.

2 Press and hold / button for two seconds during
playback. And then release at a point you want.
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EZ menu of the Text

You can set the desired function or switch to other
modes using the EZ menu.

Press to select the EZ menu while viewing the
text.

DUAL
• Music : You can listen to music while viewing the text 

simultaneously.
[Music] k [ (Moving to EZ menu of the 
text] k [Music] k [Cancel]/[Play Previous]/ 
[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays the previous music.
- [Play Next] : Plays the next music.
- [Back] : Moves to the music mode.

• Radio : You can listen to the radio while viewing the 
text simultaneously.
[Radio] k [ (Moving to EZ menu of the 
text] k [Radio] k [Cancel]/[Previous 
Channel]/[Next Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous 

channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

Bookmark
You can move to the point you set while playing the text.
• Set

Sets the bookmark.
• Move

Executes the bookmark.
• Cancel

Cancels the bookmark.

Auto Skip
Sets an interval for auto text skipping.
You can select [Off], [3 sec], [5 sec], or [10 sec].

Find Page
You can move to the desired page.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Control box
You can select the control box.
• On : Displays the control box.
• Off : Cancels the display of control box.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(File Name, File Size, Page, Setting)
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All Files
1 Select of the home menu.

2 You can confirm and play the playable list on each
mode.

Game
1 Select the icon of the home menu.

[Dynamic HEADING] game
Heading for both side of balls that mission will be 
succeed.
Do not pile up the over 5 balls in given time. 
Many kinds of items will appear.

[PIKKO] game
See the tail of wind, put PIKKO by pressing PIKKO
the basket. 
Chances are just 5 times! You can get the lost
chances in every 5 success by one. High score is the
most succeed chances.

2 Press the desired game file.
- For details, see the [HELP] menu.
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SYSTEM
Displays the files that are 
connected with system.

RECORD
Displays the prerecorded
files. 

CONFIG
Displays the files that are 
connected with configuration.



Settings

Music
Play Mode
• Repeat One

Plays the current file repeatedly.
• Play All

Plays all music within the selected folder in order.
• Repeat All

Plays all music within the selected folder repeatedly.
• Random All

Plays all music within the selected folder randomly.
• Random Repeat All

Repeats all music within the selected folder randomly.

Music Speed
You can set the playing speed of MP3 files.

- You can select [0.3 times], [0.5 times], [1 time], [1.5
times], and [2 times].

- The default value is [1 time].
- MP3 files sampled at less than 32KHz can support

only [1 time].

Sound Effect
- EQ: You can set the sound effect.

(AUTO EQ, NORMAL, POP, ROCK, R&B/SOUL,
HIPHOP/RAP, JAZZ, CLASSICAL, DANCE, LIVE,
USER EQ)

- 3D Sound: You can experience 3D sound effects.
(Off, 3D EXPANDER, STADIUM, CONCERT HALL,
CLUB, ROOM, BASS BOOST, X-LIVE)

Fade In
You can gradually increase the volume to protect ears.
- You can select [On] or [Off].

Scroll Speed
Sets the speed of the file name and ID3 tag information
in the music playing mode.
- You can select [Off], [0.5 times], [1 time], [2 times], and

[3 times].

Search Interval
You can select the slide show interval.
- You can select [3 sec], [5 sec], [10 sec], or [30 sec].

Lyrics
You can show the lyrics if a music file supports the lyrics.
• On : Sets the lyrics view.
• Off : Cancels the setting of lyrics view.

Background Setting
You can select a photo file for music background.
• Album Art : Displays the album jacket during playback.
• User Image : Displays the user’s photo during 

playback.
• Default Image : Displays the basic photo during 

playback.

Movie
Search Speed
You can set the playing speed of movies files.
• 1 time : Searches at an original speed.
• 2 times : Searches at 2 times speed.
• 3 times : Searches at 3 times speed.

MXD Engine Effect
You can show a high-definition image of movie files.
- You can select [On] or [Off].

Photo
Slide show
You can set the slide show to On/Off.
• On : Turns on the slide show.
• Off: Turns off the slide show.

Slide Interval
You can set the slide show interval to [2 sec], [3 sec], 
[4 sec],or [5 sec].

Text
Font Color
You can set the character color in the text mode.
- You can select [White], [Gray], [Green], [Blue], [Yellow],

or [Red].

Auto Skip
Sets an interval for auto text skipping.
- You can select [Off], [3 sec], [5 sec], or [10 sec].
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Settings
Radio
Mode
You can set the reception mode.
- You can select [Auto], [Stereo] or [Mono].

Sensitivity Setting
The lower, the more frequency channels.
- You can select [High], [Standard], or [Low].

Region Setting
You can set the reception area.
- You can select [Korea], [Japan] or [Others].

Reserved Recording
You can reserve the FM radio recording.
- You can set the frequency for reserved recording.
- Reserved recording feature is activated only when MP3

player is turned off.
- You can set only one reserved recording.
- Recording can be made for maximum 23 hours and 59

minutes.

Background Setting
You can select the photo file to background while listen-
ing to the radio.
• User Image

Displays the user’s photo during playback.
• Default Image

Displays the basic photo during playback.

Record
Recording Quality
You can set the quality of the recorded file.
- You can set [96kbps], [128kbps], or [192kbps].

VAD
In case of voice recording, recording will automatically
stop upon mute sound and will resume upon reception of
the voice signal.
- You can select [On] or [Off].

Time
Sleep Reservation
When the defined time passes, MP3 player will be auto-
matically turned off.
- You can select [Off], [10 min], [30 min], [1 hr], 

or [2 hr].
- If you set the turning-off reservation, MP3 player

will automatically store files and be turned off at the
reserved time.

- After MP3 player is turned off at the reserved time, the
turning-off reservation will be automatically cancelled.

Time System
You can set the current time in 12/24 hour time system.

Time Setting
You can set the current time.
- You can set years between 2001 and 2099.
- When downloading files in MTP mode, the time

setting of MP3 player will be synchronized with the one
of the PC.

Display Setting
Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 5.

Theme Setting
Sets menu type.
- You can select [Icon type] or [List type].

Menu Color
You can set the color of the home menu to [Red]/[Blue].

General
Control Box
You can select the control box.
• On : Displays the control box.
• Off : Cancels the display of control box.

Rebuilding
You can search the downloaded files and upgrade the list.
- You can select [Yes] or [No].
- If you select [Yes], the list will be upgraded. If you

select [No], MP3 player will return to the general setting
screen.

- As updating the list may take time, check the battery
status in advance.

Initialize Settings
You can initialize the setting of MP3 player.
- You can select [Yes] or [No].
- If you select [Yes], MP3 player is automatically turned

off after MP3 player is initialized.
- If you select [No], MP3 player moves to the previous

menu.
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Setting
System Info
You can check the product information.
- The entire memory space, the used memory space,

remaining memory space, the model name and
firmware version are displayed.

Language
You can select the language.
- Korean, English, Portuguese, Russian, Danish,

German, Dutch, French, Hungarian, Italian, Norwegian,
Polish, Spanish, Swedish, Thai, Chinese (Traditional),
Ukrainian, Finnish

Power Management
• Auto Display Off

If no button is inputted during the given time, the LCD
will be automatically turned off.
- You can select [Off], [5 sec], [10 sec], [30 sec], or 

[60 sec].
• Auto Power Off

If no button in selected in the standby mode for playing,
the screen will be automatically turned off.
- You can select [Off], [30 sec], [1 min], [5 min], or 

[10 min].

PC Connection Setting
• Media Device(MTP) Mode

- The MTP applies the latest technology of Microsoft to
support the multimedia devices. It is recognized as a
mobile devices and compatible with Windows Media
Player10.

• Removable Disk(MSC) Mode
- MP3 player will function as a general removable 

storage in this mode.

Format
You can delete all data in the memory and initialize the
memory.
- You can select [Yes] or [No].
- If you select [Yes], formatting will be made. If you

selects [No], MP3 player will return to the general setup
screen.

- Back up the data stored in MP3 player before initializ-
ing
it.

- Deleted data cannot be recovered.

Calibration
You can adjust a focus on LCD.
- Press “+” repeatedly.

Voice recording
1 Press the REC more than 1 second and then press

[Start].

- The recording will start.

2 Press [Pause] to pause.
3 Press [END] to end the recording.

- Select [Continue] to resume recording.
- The recorded files will be stored under Record folder

named V061205_xxxx (Year Month Date_Order)

4 Refer to [Recorded file] on the page 25 to play 
prerecorded files.

Note
If the remaining memory space is less than 4MB, the 
player may not be recorded.
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Q :MP3 player will not be turned on.
A : Check whether the battery is remaining.
A : Connect the AC adapter and charge the battery.

Q : The screen is blur.
A : Avoid direct sun rays and adjust the brightness.
A : Check the LCD brightness.

Q : The button does not function.
A : Check whether the Hold feature is active.

Q : The characters on display look broken.
A : Download the font file from the website and copy 

it to the Config folder.
A : The Config folder is displayed only in MSC 

mode. Change to the MSC mode (In case of MTP
mode, copy the font file to the data folder).

Q : The noise is severe during listening to the radio,
and the reception is poor. (FM  radio reception is
optional.)
A : The earphone functions as an antenna. Be sure to

handle carefully.
A : Slightly change the directions of MP3 player and 

the earphones.

Q : After the files are downloaded, the play list will
not show the newly added files.
A : Upgrade the list in Setup menu.
A : Format the product and download the file.

- If you format MP3 player, all data in it will get 
lost.

Q : After the firmware is upgraded, MP3 player is not
normally functioning.
A : Reset the product (See page 20)
A : Back up the data and format MP3 player.

- If you format MP3 player, all data in it will get 
lost.

Q : Sometimes, files are not downloaded.
A : Check the PC Connection Setting of MP3 player. 

(See page 14 - 16.)

Q : Files can not downloaded.
A : Check the PC Connection Setting. Some files can 

be downloaded depending on the PC Connection 
Setting. All files can be downloaded in MSC 
mode.

Q : The PC can not recognize an MP3 Player.
A : Check the PC Connection Setting. In the case of 

Windows 98 SE/ME, PC Connection Setting
should be set to MSC in Setup Menu.

A : Check if the USB driver on the provided CD is 
installed.

Q : AVI/WMV file will not play.
A : Only video files transcoded by LG Media Center 

can be played. Make sure the files to be played 
are converted by LG Media Center. Refer to the 
LG Media Center [Help] on how to transcode your 
files.

Q :Characters are not shown properly in text files.
A : If the text file is encoded in a format that your text 

file viewer doesn't understand, text data seem to 
be garbaged or corrupted.

A : You should convert the text file into Unicode on a 
PC which supports your language of choice and 
download it.

A : Set the characters to the corresponding 
languages in [Settings] k [General] k 

[Language].

Q :ID3 TAGs of the music are broken or are not dis-
played.
A : Set the ID3 TAGs to the corresponding languages 

in [Settings] k [General] k [Language].
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Capacity 1GB/2GB/4GB

File system FAT32

OS for MP3 Player Device Win98SE/ME/2000/XP

OS for LG Media Center Win2000 / XP

Interface USB 2.0

Dimensions 51.5 (W) X 90 (H) X 9.9 (D)

Weight 63g (2.22oz) (with battery) / Depends on the product 
model.

Operating temperature 0°C + 40°C

Frequency range 20Hz ~ 20kHz

Signal-to-noise ratio 90dB

Channel response 40dB (1kHz)

Maximum output 18mW+18mW

Frequency range 87.5~108MHz

Signal-to-noise ratio 38dB

Channel response 22dB (1kHz)

Antenna Earphones antenna

Video About 3 hours

Audio About 20 hours (for 128Kbps/44.1KHz EQ 
normal)

AC adapter DC5V, 1A

Battery (Built-in) Lithium Ion DC 3.7V 600 mAh 
Chargeable Battery

Audio MP3, OGG, WMA, WAV (ADPCM), ASF

Video LG AVI (30 frames), LG WMV (30 frames)

Image viewer JPG

Text viewer TXT

TFT LCD 2.4" / 260,000 colors

Memory

PC

General specifications

Audio

FM radio
(Optional according
to model)

Playback time

Power supply

Type Item Specifications

http://www.lge.com
Information related to the product is available at this
site.
- By updating the firmware, you can improve the 

performance of the product.

Note
Some parts of the storage space of the MP3 player are usually used for storing the information that is internally treated.
Therefore, the storage capacity that can be actually used may be somewhat smaller than specified in the manual.
(The size of the storage space for the internally treated information can be changed for product upgrade without any
notice to the end users.)

Files

Display



Supported file specification
MP3 Decoder
- MP3 decoding support specification including variable

bit rate (VBR)
MP3 Encoder
- 44.1KHz, (96Kbps, 128Kbps, 192Kbps) Spec
WMA Decoder
- WMA (ASF-audio only) Decode Support

- (S): Stereo,  (M): Mono

OGG Decoder
- Q(-1) ~ Q(9) Support
ADPCM Decoder
- WAV File Format (MS-ADPCM) Decode
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32 OK OK OK

40 OK OK OK

48 OK OK OK

56 OK OK OK

64 OK OK OK

80 OK OK OK

96 OK OK OK

112 OK OK OK

128 OK OK OK

144 OK OK OK

160 OK OK OK

192 OK OK OK

224 OK OK OK

256 OK OK OK

320 OK OK OK

Bitrate 32KHz 44.1KHz 48KHz
Mpeg1
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